iMovie
Create, edit, and share stunning movies on your Mac and iOS device

Dion Scoppettuolo

Lesson and media files available for download
My deepest gratitude to Patty Montesion for all of her help and inspiration.
## Contents at a Glance

Getting Started .................................................. xi

### iMovie for Mac

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Setting Up Your Library</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Enjoying and Sharing Clips</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>Moviemaking Made Easy</td>
<td>39</td>
</tr>
<tr>
<td>4</td>
<td>Having Fun with iMovie Trailers</td>
<td>61</td>
</tr>
<tr>
<td>5</td>
<td>Creating Your Own Sports Highlights Video</td>
<td>79</td>
</tr>
<tr>
<td>6</td>
<td>Editing Video and Audio</td>
<td>95</td>
</tr>
<tr>
<td>7</td>
<td>Fixing and Refining the Look</td>
<td>119</td>
</tr>
<tr>
<td>8</td>
<td>Making an Advanced Slideshow</td>
<td>143</td>
</tr>
<tr>
<td>9</td>
<td>Advanced Moviemaking</td>
<td>183</td>
</tr>
<tr>
<td>10</td>
<td>Managing Your Library</td>
<td>207</td>
</tr>
</tbody>
</table>

### iMovie for iOS

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Learning the Fundamentals of iMovie for iOS</td>
<td>221</td>
</tr>
<tr>
<td>12</td>
<td>Producing a One-Minute Movie</td>
<td>237</td>
</tr>
<tr>
<td>13</td>
<td>Mobilize Your Movie Making</td>
<td>259</td>
</tr>
<tr>
<td>Bonus 1</td>
<td>Sharing to iMovie Theater (Mac)</td>
<td>BL1-1</td>
</tr>
<tr>
<td>Bonus 2</td>
<td>Sharing to iMovie Theater (iOS)</td>
<td>BL2-1</td>
</tr>
</tbody>
</table>

Index ........................................................................ 311
# Table of Contents

Getting Started ........................................... xi

**iMovie for Mac**

**Lesson 1**  
**Setting Up Your Library**  ................................... 3  
Understand the iMovie Library .................................. 4  
Download Videos for This Book ............................... 5  
Navigate the iMovie Window ................................. 6  
Working with Multiple Libraries ............................ 7  
Lesson Review .................................................. 8

**Lesson 2**  
**Enjoying and Sharing Clips** ................................ 11  
Importing Clips into iMovie ................................. 12  
Skimming and Playing Clips ................................. 15  
Changing the Display of Filmstrips ....................... 16  
Marking the Best and Worst Clips ......................... 18  
Filtering Events .............................................. 28  
Deleting Clips from an Event ............................ 29  
Enhancing Clips ............................................. 30  
Playing Clips Full Screen ................................ 33  
Sharing Clips in Email .................................. 34  
Lesson Review .................................................. 36

**Lesson 3**  
**Moviemaking Made Easy** .................................. 39  
Creating a Movie with a Theme ............................ 40  
Dragging Selections to the Timeline ....................... 41  
Placing Clips Where You Want Them ..................... 43  
Adding Selections to the End ............................ 47  
Removing Clips from a Movie ........................... 51
Contents

Rearranging Clips in a Movie ........................................ 52
Auditioning and Adding Music ................................. 53
Changing Themes ................................................. 56
Playing a Movie Full Screen .............................. 57
Sharing Movies to Facebook ............................... 58
Lesson Review ................................................... 59

Lesson 4 Having Fun with iMovie Trailers ............... 61
Selecting a New Event ........................................... 62
Selecting a Trailer Genre .................................... 62
Changing the Outline ........................................... 64
Filling in the Storyboard ..................................... 65
Replacing Clips in a Trailer ................................... 72
Using the Clip Trimmer ......................................... 73
Enabling Clip Audio ............................................. 75
Personalizing the Storyline ................................... 76
Lesson Review ................................................... 77

Lesson 5 Creating Your Own Sports Highlights Video ...... 79
Switching Projects in the Library ............................ 80
Applying a Theme to an Existing Movie ..................... 80
Using the Sports Team Editor .................................. 82
Adding Titles and Backgrounds ............................. 86
Creating an Instant Replay Effect ............................ 88
Highlighting a Player ............................................. 90
Lesson Review ................................................... 93

Lesson 6 Editing Video and Audio ............................ 95
Creating a Movie Without a Theme ......................... 96
Editing a Movie .................................................. 98
Working with Audio ............................................ 106
Lesson Review ................................................... 117

Lesson 7 Fixing and Refining the Look ...................... 119
Using Video Effects ............................................ 120
Previewing and Modifying Transitions ..................... 123
Changing Clip Playback Speed .............................. 125
Contents

Fixing Color Problems ........................................ 126
Stabilizing a Clip ............................................. 135
Working with Titles .......................................... 136
Sharing Movies Online ....................................... 138
Lesson Review .................................................... 141

Lesson 8 Making an Advanced Slideshow ............... 143
Accessing iPhoto ................................................. 144
Importing Photos .................................................. 146
Finding Photos in the Browser ............................... 147
Adding Photos to a Movie ...................................... 149
Add a Cutaway ..................................................... 151
Adding Cross Dissolves to Cutaways ....................... 162
Cropping Photos in the Viewing Area ....................... 164
Modifying the Ken Burns Effect ............................. 167
Freezing on a Frame ............................................ 172
Editing a Title ...................................................... 173
Ducking Music ..................................................... 177
Lesson Review .................................................... 181

Lesson 9 Advanced Moviemaking .......................... 183
Choosing Projects from the Library ......................... 184
Setting a Location Using Travel Maps ....................... 185
Trimming with the Precision Editor ......................... 187
Recording Narration ............................................ 193
Using Audio from a Video Clip ............................... 196
Mixing Audio ....................................................... 198
Lesson Review .................................................... 205

Lesson 10 Managing Your Library ......................... 207
Understanding Video Formats ............................... 208
Adjusting a Clip’s Date and Time ............................ 212
Making Backups ..................................................... 214
Bonus Lesson: iMovie Theater for Mac ..................... 217
Lesson Review .................................................... 218
iMovie for iOS

**Lesson 11**  
**Learning the Fundamentals of iMovie for iOS**  
- Understanding iMovie for iOS  
- Browsing and Playing Clips  
- Tagging Your Favorite Clips  
- Changing the Filmstrip Display  
- Sharing Clips to Facebook  
- Lesson Review

**Lesson 12**  
**Producing a One-Minute Movie**  
- Picking a Trailer Genre  
- Edit the Outline  
- Filling in the Storyboard  
- Changing Clips in a Trailer  
- Personalizing the Storyline  
- Lesson Review

**Lesson 13**  
**Mobilize Your Movie Making**  
- Starting a New Movie  
- Using the Playhead  
- Rearranging Clips in a Movie  
- Adding and Adjusting Audio  
- Applying Transitions and Titles  
- Switching Themes  
- Using Photos in a Movie  
- Advanced Movie-Making Options  
- Saving and Moving Projects  
- Deleting Clips and Projects  
- Access the Bonus Lesson: Sharing to iMovie Theater  
- Lesson Review

**Bonus 1**  
- Sharing to iMovie Theater (Mac)  

**Bonus 2**  
- Sharing to iMovie Theater (iOS)

**Index**
Welcome to the official Apple training course for iMovie 10 for OS X and iMovie 2 for iOS. You don't need to have any special background to get started, other than having a Mac and/or an iOS device (and perhaps a healthy curiosity about what you can do with home video using Apple products).

Learning iMovie will teach you how to integrate your Mac and iOS device comfortably into your home, school, and work by weaving digital and mobile video into your daily life.

In this book, you’ll learn how real people use iMovie. You’ll skip some of the more advanced functionality with an eye toward having fun, achieving quick success, and forming a foundation of confidence on which you can build.
**What iMovie Does for You**

There was a time when your home videos were on a VHS tape in the closet, or just stored somewhere on your computer or mobile device. Organization wasn't even a consideration, so finding a particular video clip was a chore.

But when all your video clips are digital, keeping them organized is streamlined, sharing them is easy, and presenting them in a variety of stunning ways is both simple and fun.

A Mac is designed to function at the heart of your digital life. It’s a computer designed for creativity. Your iPhone is one of the most popular cameras in the world. And given that Apple provides iMovie free on all new Mac computers and iOS devices, there is no better time to learn how to take advantage of it all.

What iMovie teaches you is **visual literacy**. The ability to communicate effectively through video is different from speaking or writing. Making high-quality, fun home videos is a skill you can apply throughout your life. Once you develop a few simple editing skills, you’ll be stunned by how often you use them, whether for personal pleasure or to your commercial advantage.

Learning software is seldom enjoyable. But sharing video clips or creating home movies, promoting your business, or building a creative video report for school can be fun. You’ll end up learning the software along the way.

**The Methodology**

This book moves through lessons by progressively increasing the complexity of what you do with video clips. You start by viewing and sharing your favorite clips, and then move to creating fun projects like movie trailers. In bonus lessons you’ll explore the possibilities of Apple’s iCloud with iMovie Theater.

Above all, these lessons are meant to be practical—not esoteric projects to show off the software, but real-life projects for people with time constraints and well-worn equipment. The lessons cover iMovie for Mac and iMovie for iOS in two different sections.

**iMovie for Mac**

In Lessons 1 through 10, you’ll work with video clips from the provided APTS iMovie library. You’ll learn how to edit video and share video clips; how to create fun home movies; and how to manage your library of video. In a bonus lesson you learn how to share photos using iCloud with iMovie Theater on the Mac.
iMovie for iOS

In Lessons 11 through 13, you’ll get a thorough walkthrough of iMovie for iOS devices. In these lessons, since space is limited on your mobile devices, you’ll work with your own video clips as you follow the detailed steps to guide you. You’ll learn how to move video clips from your Mac to iOS, how to mark your favorites, and how to share them on popular social networks. Then you’ll learn how to create fun, Hollywood-style coming attractions and polished home movies. In a second bonus lesson you’ll learn how to use iMovie Theater so that you and your viewers can easily watch your movies on all iOS devices, Mac computers, and even Apple TV.

A Word About the Lesson Content

Often, training materials are professionally created, using actors and complicated productions with multiple cameras and a crew. The resulting material is of high quality but probably bears little similarity to the kind of home video most families have or self-employed business owners can produce.

To make this training as real-world and practical as possible, all the media used in this book was made in precisely the way you would make your own home video. The quality of the video (for better or worse) is comparable to what you can get with consumer video cameras and the iPhone, and the sophistication of the projects is precisely what you can achieve using iMovie, with settings (and challenges) you will commonly encounter yourself.

We tried to make sure the events depicted here were recorded in the way you’re being taught to work. Ideally, this will give you clear and realistic expectations about what you can do with your newfound skills.

System Requirements

This book is written for iMovie 10 for OS X Mavericks, which comes free with any new Macintosh computer. It also covers iMovie 2.0 for iOS devices running iOS 7. If you have an older version of iMovie, you’ll need to upgrade to the current iMovie version to follow along with every lesson. The upgrade can be purchased through the Mac and iOS App stores.

Before you begin the lessons in this book, you should have a working knowledge of your Mac, its operating system, your iPhone or iPad, and the iOS operating system. You don’t need to be an expert, but you do need to know how to use the mouse, standard menus,
and the iOS 7 touch screen. You should feel comfortable with opening, saving, and closing files on the Mac, and know how to tap, swipe, and pinch on iOS. You should have a working understanding of how OS X helps organize files on your computer, and you should also be comfortable opening applications on your Mac and iOS device. If you need to review any of these techniques, see the printed or online documentation that came with your device.

Some features require an Apple ID and an Internet connection.

**Copying the iMovie Lesson Files**

The *Apple Pro Training Series: iMovie* lesson files must be downloaded to your Mac in order to complete Lessons 1 through 10 in this book. After you save the files to your hard disk, each lesson will instruct you in their use.

To download these files, you must have your book’s access code—provided on a card in the back of the printed editions of this book or on the “Where Are the Lesson Files?” page in electronic editions of this book. When you have the code, proceed with the following installation instructions.

For complete download instructions, see “Download Videos for This Book” in Lesson 1.

**Resources**

*Apple Pro Training Series: iMovie* is not intended to be a comprehensive reference manual, nor does it replace the documentation that comes with the application. Rather, the book is designed to be used in conjunction with other comprehensive reference guides. These resources include:

- Companion Peachpit website: As iMovie is updated, Peachpit may choose to update lessons as necessary. Please check www.peachpit.com/APTSiMovie.
- The Apple website: www.apple.com
- Apple Pro Training Series books: *Apple Pro Training Series: iPhoto*, by Dion Scoppettuolo, is an excellent companion to this book. Learn how to use iPhoto to enhance your photos, create slideshows, and print keepsake photo books on both OS X and iOS 7. *Apple Pro Training Series: GarageBand*, by Mary Plummer, is an in-depth look at GarageBand, in which you build songs, podcasts, and movie scores from scratch, and explore some of the advanced mixing and arranging features of GarageBand.
Acknowledgements

We would like to thank the following individuals for their contributions of media used throughout the book: Larry Word and the Word family for the Old Home Movies event; Taryn Jaune Glass Blowing for the Glass Blowing video. Leo Bechtold for the Bhutan Tiger’s Nest video; Raymond Melcher for the Marlins Spring Training video; and Alexander Blakley for the Max and Louisa in NYC video.
Lesson Files

Desktop > APTS iMovie Lesson Files > APTS iMovie Library > My Dog Nima

Time

This lesson takes approximately 75 minutes to complete.

Goals

Choose a new event
Select a trailer
Change the outline
Fill in the storyboard
Remove clips from a trailer
Customize a storyline
Lesson 4

Having Fun with iMovie Trailers

Creating iMovie trailers is another simple way to produce an enjoyable, if short, movie. Trailer is a term used in Hollywood to describe the coming attractions you see before a feature presentation. iMovie trailers are a slick, fun way for you to turn your clips into bigger-than-life, Hollywood-style coming attractions.

In this lesson, you’ll select a movie genre and then customize a storyline to fit your home video. Finally, you’ll add clips according to the iMovie storyboard directions.
Selecting a New Event

Before you begin creating a trailer, open a different event in the browser. These clips are somewhat more contemporary than the clips you used in the previous lessons.

1. From the Libraries list, select My Dog Nima. This is an event filled with clips of a small puppy, Nima, taken over the course of a year.

You won’t need to see the Golden State movie you created in the previous lesson so you can close the timeline.

2. Click the Close button in the upper-left corner of the timeline, if the timeline is not already closed.

You’ll use clips of Nima to make the trailer but first you’ll need to change the sort order back to ascending. You may recall that you sorted them in descending order in Lesson 2.

3. Choose View > Sort By > Ascending.

The browser is sorted to show the clips from the earliest to the most recent. You can skim over a few clips to get an idea of what the browser contains.

Selecting a Trailer Genre

Movie trailers are a specific project type that you create in the same way you created the movie in Lesson 3.

1. In the toolbar, click the Create button and choose Trailer from the pop-up menu.
The Create window displays the available trailer templates.

2 Click the Adventure trailer to select it.

Below the thumbnail is information on how many “cast members” this trailer requires and its duration.

3 Click the Play button in the trailer thumbnail to preview it, and then click it again to stop the preview.

TIP Some of the trailers, such as Blockbuster, Expedition, and Family, allow you to change the number of cast members.

This seems like a good trailer to create for an adventurous puppy.

4 In the Create window, click Create.

5 Name your trailer *Nima and the Dog Bone of Destiny*.

6 Click OK to begin creating the trailer.
**NOTE** Unlike with movie themes, you can't switch trailer genres after you begin creating your trailer. To use a new trailer genre with the same video clips, you must create a new trailer.

The tabbed Trailer window appears, and the trailer thumbnail is added to the browser.

### Changing the Outline

In the Outline pane, you can personalize the storyline text that accompanies your trailer. You'll be able to customize elements such as the cast list, the release date of your movie, and a studio name and logo. Although every line item in the outline can be changed, the name you typed for the trailer is used for the title. You'll start by changing the name of the lead character.

1. On the Cast Star line, click the name Jake and type *My Dog*.

![Cast](image)

2. Double-click the name Callahan to highlight it, and then type *Nima*.

   You’ll also need to change the gender so that any titles using pronouns will use the correct pronoun.

3. Choose Female for Nima's gender.

4. Change the studio name to *BOW WOW FILMS* (yes, you're going to carry this dog theme pretty far).

5. To change the studio logo, place the mouse pointer over the Snowy Mountain Peak. The viewing area shows the Snowy Mountain Peak studio logo, which—due to international copyright laws—looks similar but is clearly different from the logo of an actual large Hollywood movie studio.

6. Click the Snowy Mountain Peak text. A menu of alternative imitation studio logos appears.

7. Select Spinning Earth in Space to change the current logo.
In the Outline pane, scroll down to view the credits that will appear at the end of your trailer.

Move the pointer over the credit text to preview the credits in the viewing area.

By default, iMovie fills in the credit list using the My Card setting in the address book of your Mac, but you can change each credit as necessary. You’ll leave that part for later, and move on to adding clips.

**Filling in the Storyboard**

With the outline personalized, you can move on to the storyboard.

1. Click the Storyboard tab.

   The storyboard contains placeholders that describe the types of clips to add, how long those clips should be, and an appropriate clip order. Playing the trailer first without adding any clips is good way to get a sense of what you’re creating.

2. At the top of the storyboard, skim to the start of the BOW WOW FILMS title.
3 Press the Spacebar to play the trailer.

The trailer includes titles, music, and all the placeholders you need to create a complete coming attraction. All you need to do is select your best clips to match the placeholder descriptions.

4 Halfway through the trailer, press the Spacebar to stop. Then scroll the storyboard to the top.

The first placeholder is highlighted yellow to give you an indication of the type of clip you need to find. In this case, you want a 2.7-second landscape clip. Clips with a shorter duration will not work. In the browser is a 10.2-second scenic clip, so you’ll use that.

5 In the browser, skim over the first clip (the scenery clip) and move your pointer over it.

When the pointer moves over the clip, a yellow selection highlight moves with it. This yellow highlight indicates how much of the clip will be used once you click the mouse.

Adding clips for trailers works a bit differently than adding clips to a movie because the placeholder predefines the length of the clip. So all that is left for you is to decide where the clip will start.

6 Skim along the scenic clip in the browser until somewhere in the middle of the filmstrip.
7 Click the mouse button to add this to the trailer.

The placeholder is filled in with the selected clip, and the yellow highlight moves to the second placeholder in the storyboard.

This next placeholder requires a clip of Nima. This is the first time she’ll appear in the trailer, so the clip should clearly introduce her.

8 Skim over the second clip (Nima sitting on gravel). Towards the end of this clip is a nice point where she turns her head from left to right (your left to right, not hers).

9 Skim to the point where Nima starts to turn, and then click to add this clip to the trailer.

This next placeholder in the storyboard is highlighted. This is where the next clip you add will be placed. From the title under the placeholder, it is looking for another a clip of Nima.
10 Skim over the third clip of Nima laying down, yawning.

This is a video of Nima yawning—another perfect introductory clip because it’s a classic pose of hers (and every dog). It’s also a much more close-up clip than the one of her sitting on the gravel.

12 Click to add the third clip to the trailer.

This is a good place to pause and view the trailer so far.

13 Skim to the start of the Bow Wow Films title at the top of the storyboard.

14 Press the Spacebar to play the trailer.

15 After the third clip plays, press the Spacebar to stop playback and get ready to add more clips.

The next placeholder suggests a medium shot. Traditionally in moviemaking a medium shot is usually framed so the bottom of the shot begins at the knees or waist of the subject. How does that translate when the subject is a dog? It’s anyone’s guess. The beauty of the trailer is that these placeholders are just suggestions. You can follow them loosely and still end up with a fun movie. The fourth clip in the browser is just Nima sniffing around, which will work, but the fifth placeholder is looking for another landscape, which you don’t have. So you’ll just fill in the placeholders by going in the order they appear in the browser.
NOTE ▶ The placeholder clip description (medium, close-up, long shot) is just a suggestion. You can select any type of clip composition, but the duration cannot be shorter than the placeholder.

16 Click anywhere in the middle of the fourth clip (Nima sniffing around).

17 Click anywhere in the middle of the fifth clip (Nima standing on the red patio).

18 Add the sixth clip (Nima testing the water) by clicking the start of the clip.
19 Use the next two beach clips for the next two medium placeholders by aligning the end of the yellow selection outline with the end of the clips.

20 The ninth placeholder asks for an action clip. Click the next clip at the beginning (Nima running across the floor).

21 Add the remaining clips in the browser by clicking at the start of each one, beginning with the close-up of Nima gnawing on a toy and ending with the shot of Nima being playful on the gravel.
Start with Nima gnawing on the toy.

End with the clip of Nima playful on the gravel.

Your exciting adventure trailer is complete, and you can skim to the beginning and play it to see what you’ve created. It’s a fun movie to watch and really simple to create, but you can still make some changes to improve it.
Replacing Clips in a Trailer

In some cases you may want to replace one clip in the trailer with another one.

1. In the storyboard, skim to the last clip (Nima playful on the gravel).
   This clip is very shaky, and you have one more unused clip in the browser.

2. In the upper-right corner of the clip’s thumbnail, click the Undo button.

   ![Undo button](image)

   The yellow highlight appears around the now-empty placeholder.

3. In the browser, skim to the last clip of Nima looking across the patio.

4. Skim the clip to locate the point where Nima begins to turn her head, and then click to fill in the empty placeholder.

5. Skim back in the storyboard to the “action” clip of Nima sniffing on the seaweed, and then press the Spacebar to play and see your change.
Knowing that you can change your trailer even after all the placeholders are filled relieves the creative pressure when you're producing your first few cinematic masterpieces.

**Using the Clip Trimmer**

Although each clip in the trailer has a predefined length, you can change the range used by adjusting it in the clip trimmer.

1. In the Storyboard pane, skim to the “On a Quest for Glory” title. Then skim four clips ahead to the “action” clip of Nima running across the kitchen floor.

   ![Image of Nima running](image)

   This is a nice clip, but her entire running action is missing because the clip ends too soon. Let's try to shift this clip to remove some of the boring beginning frames and add some of the action to the end.

2. Click the Clip Trimmer button.

   The clip trimmer opens above the browser and shows a more detailed view of the entire clip, as well as the selected range from the trailer.
3 In the clip trimmer, skim over the clip to view when Nima starts to run. As you can see, the best part wasn’t included, so you’ll reposition the selected range to include the run.

4 Position the mouse pointer just before the ball leaves the man’s hand.

5 Click the filmstrip to change the selection range, and then click the Close Clip Trimmer button.

6 To view your change, skim back to the “wide” shot of Nima gnawing on the toy and press the Spacebar to begin playing.

**TIP** If you want to add more clips than the trailer allows or change a clip’s length, you can convert the trailer to a movie by choosing File > Convert Trailer to Movie. After you convert it to a movie, you cannot convert it back to a trailer, so it’s wise to duplicate the trailer by choosing Edit > Duplicate Trailer.

The trailer is complete, and you can play it to review what you’ve created. It’s a delightful movie to watch, but you could still improve it.
Enabling Clip Audio

When you add clips to a trailer, the audio from those clips is muted so as not to interfere with the dramatic music. In many cases matching the audio with the storyline of the trailer is tricky. In our case, adding a bark here or there from the action video clips will not significantly take away from the drama.

1 In the Storyboard pane, skim to the 1.1-second “wide” shot near the end of the trailer (Nima on the gravel).

If you skim over this clip, you can see she is barking. It might be nice to add her voice to her trailer so her fans can hear her.

2 In the upper-left corner of the thumbnail, click the Audio button.

3 To view your change, skim back a few clips and press the Spacebar to begin playing. The audio adds a little personal touch to this trailer. You can add more of your own personal touch to this trailer by changing some of the storyline Apple provides.
Personalizing the Storyline

You can personalize the trailer’s storyline by changing its text. Every line of text in the trailer can be rewritten. In this trailer, the main title at the end reads, “Nima and the Dog Bone of Destiny.” That’s a dramatic title, but the other titles throughout this trailer are the stock ones provided by Apple. You’ll personalize one now.

1. Skim down to the title “On a Quest for Glory.”

![On a Quest for Glory]

2. Click the word “Glory.”

Most titles are divided into sections based on the style of the text in the title. You can see “Glory” has a different appearance in the viewing area than “On a Quest for.” You can change both pieces of text, but Apple divides them up to let you know which text will be in which style.

3. Replace “Glory” by typing a bone.

4. Click outside the text box to stop text editing.

**Tip** After you change text in the storyboard, the right side of the text box displays an Undo button. Click the Undo button to restore the original text.

The changes made in the Storyboard pane can be seen in the viewing area as you type, and you can play the trailer to see the entire movie.

5. Skim to the clip before the title in the storyboard, and press the Spacebar to view your changes.

Trailers offer a unique way to show off your video clips in style. And just like the movie you made in Lesson 3, you can share it to Facebook or another social network supported in iMovie.
Lesson Review

1. Where do you find the choices for movie trailers?
2. How can you change the studio logo at the beginning of the movie trailer?
3. What determines the length of a clip added to the trailer?
4. True or false? Once you add a clip to a trailer you cannot change it.
5. True or false? You can change the trailer style at any time while you are making the trailer.

Answers

1. Movie trailers are located in the Create window when you click the Create button and choose Trailers.
2. Once you create a new trailer, you can select a studio logo from the Outline pane.
3. A clip’s length is determined by the placeholder in the trailer.
4. False. You can change a clip in the trailer by clicking the Undo button and clicking another clip in the browser.
5. False. Once you begin creating a trailer, you must start over again if you want to select a new trailer style.
## Index

### Numbers
- 1:1 aspect ratio, 209
- 4:3 aspect ratio, 209
- 4:6 aspect ratio, 209
- 16:9 aspect ratio, 209

### Symbol
- \\ (backslash) key
  - playing music with soundtrack, 56
  - using with selections, 42

### A
- Add button, displaying, 48
- Adventure trailer, selecting, 63
- albums, creating in iPhoto library, 145
- aspect ratios
  - explained, 166
  - HD (high definition) video format, pixels in, 209
  - SD (standard definition) video format, 209
- audio. See also mixing audio; music; sound quality
  - adding to mobile movies, 270–277
  - adjusting in mobile movies, 270–277
  - equalizing, 199–200
  - muting, 112–113
  - trimming in precision editor, 191–193
  - using clip trimmer for, 113–114
  - using from video clips, 196–198
  - audio clips, fading in, 115. See also clips
  - audio content
    - iTunes library, 53
    - royalty-free soundtracks, 53
    - songs created in GarageBand, 53
    - sound effects, 53
    - theme music, 54
  - audio levels
    - keyframing within clips, 200–203
    - setting for clips, 114–115
  - audio locations, finding in cutaways, 154
  - audio skimming
    - enabling from View menu, 114
    - toggling, 154
  - audio tracks
    - adding, 108–109
    - background music, 107 connected, 107
    - connecting music tracks, 107–108
    - trimming, 110–111
    - trimming in mobile movies, 290–291
  - audio waveform, explained, 107
  - auditioning music, 53–56
  - Automatic Content, enabling, 81. See also Content Library
  - Avatar, 39

### B
- background music
  - beginning and ending, 55
  - trimming, 55
- backing up projects. See also projects
  - consolidating media, 214
  - copying libraries, 215
  - moving events to hard disks, 215–216
  - moving projects to hard disks, 216–217
- backslash (\) key
  - playing music with soundtrack, 56
  - using with selections, 42
- bonus lessons. See iOS bonus lesson; Mac OS bonus lesson
- browsers
  - adding clips to, 70
  - described, 6
  - locating in iMovie window, 41
- Burns, Ken. See Ken Burns effect

### C
- cameras, importing from, 14
cast members, customizing, 243
clearing favorite markings, 24–26
clip audio, enabling, 75
clip descriptions, including for placeholders, 69
Clip Size slider, using, 18
clip trimmer
adding clips, 74
using, 73–74
viewing changes, 74
clips. See also audio clips; favorite clips; filmstrips; Stabilizing feature; video clips
adding to browsers, 70
adding to trailers, 67–68
adjusting date and time, 212–213
changing in trailers, 251–254
changing playback speed, 125–126
connecting to skimmer, 108
deleting from events, 29–30
deleting in mobile movies, 306–308
deleting unselected parts of, 104
displaying in browser, 29
dragging into timeline, 46
enhancing, 30–33
grouping in events, 13
importing from folders, 12–15
importing into iMovie, 12–15
inserting, 100–102
marking best and worst, 18
marking favorites, 18–22
muting and unmuting, 112
navigating, 34
placing, 43–47
playing, 15–16, 21
playing full screen, 33–34
rearranging in mobile movies, 269–270
rearranging in movies, 52
rejecting, 26–28
removing from movies, 51
removing from trailers, 251
replacing, 98–99
replacing in trailers, 72–73
searching for keywords, 152
selecting all, 32
selecting ranges from, 18–22
setting audio levels, 114–115
sharing in email, 34–36
skimming, 15–16
splitting, 100–102
stabilizing, 135–136
toggling waveforms, 202
using keywords with, 147
zooming, 17
zooming in mobile movies, 297–299
color, matching between clips, 133–135
color problems
Enhance button, 127–128
fixing, 126–127
skin tone balance, 131–133
white balance, 128–131
Command key. See keyboard shortcuts
consolidating media for backups, 214
Content Library. See also Automatic Content audio in, 53
locating in iMovie window, 41
Maps & Backgrounds option, 87, 185
copying
libraries for backups, 215
and pasting video effects, 121–123
credit list, filling in, 65
Crop button, using with SD and HD video, 211–212
Crop controls, Ken Burns effect in, 168
Crop to fill button, using with Ken Burns effect, 166
cropping photos in viewing area, 164–167
cross dissolves, adding to cutaways, 162–164
cutaways
adding, 151–156
adding cross dissolves to, 162–164
adding to mobile movies, 295–297
covering up jump cuts, 156–157
finding audio locations, 154
moving, 158–161
reviewing, 156
reviewing edits, 155
start of, 155
trimming, 157
watching, 164
D
date and time, adjusting for clips, 212–213
deleting
clips from events, 29–30
clips from movies, 51
clips in mobile movies, 306–308
Ken Burns effect, 167
portions of timeline, 102–104
projects in mobile movies, 306–308
themes from movies, 96
unselected portions of clips, 104
digital cameras, importing from, 14
Dock, opening iMovie from, 4–5
downloading videos for book, 5–6
dragging clips into timeline, 46
selections to timeline, 41–43
ducking to mix audio, 198–199
music, 177–181
Ducking Volume slider, using, 180

**E**
Edit Shot pane, using, 253–254
editing movies. See also movies
deleting parts of timeline, 102–104
inserting clips, 100–102
replacing clips, 98–99
splitting clips, 100–102
trimming frames, 104–105
editing titles. See also titles
changing text style, 175–177
number of text lines, 174
using Fonts window, 176
e-mail, sharing clips in, 34–36
Enhance button
using to fix color problems, 127–128
using with clips, 31–32
equalizing audio, 199–200
events
creating, 14
deleting clips from, 29–30
filtering, 28–29
grouping clips in, 13
moving to hard disks, 215–216
selecting, 62
events, including in library, 4
free music, using, 177–181
freeze frames, creating in mobile movies, 299–300
freezing on frames, 172–173
full screen
playing clips, 33–34
playing movies in, 57

**G**
GarageBand, accessing music from, 107
grouping clips in events, 13

**H**
hard disks, moving events to, 215–216
HD (high definition) video format
aspect ratio, 209
pixels in, 208
Help menu, accessing shortcuts on, 45

**I**
iMovie
opening, 7
opening from Dock, 4–5
iMovie for iOS. See also iOS devices
browsing clips, 225–227
changing filmstrip display, 230–231
creating favorite tags, 229
Favorite button, 228
launching, 222–223
playing clips, 225–227
Share button in Facebook, 232
sharing clips to Facebook, 231–234
Slow button, 227
tagging favorite clips, 227–229
video browser, 223, 225
viewing video clips, 222–225
iMovie lesson files, installing, 5–6
iMovie Library Backup, creating, 215
iMovie Theater
  adding movies to, 36
  for Mac bonus lesson, 217–218
  sharing to, 306–308
iMovie window
  browser, 6, 41
  content library, 41
  Libraries list, 6, 41
  timeline, 41
  toolbar buttons, 6, 41
  viewer, 6, 41
Import window
  opening, 12
  selecting clips in, 14
importing
  clips from folders, 12–15
  clips into iMovie, 12–15
  from digital cameras, 14
  from iOS devices, 14
  photos, 146–147
insert edit, using, 100
inserting clips, 100–102
installing iMovie lesson files, 5–6
instant replay effect, creating for Sports theme, 88–89
iOS bonus lesson
  adding movies, BL2–5
  clip lengths, BL2–5
  deleting from iCloud, BL2–5–BL2–6
  deleting from
    iMovie Theater, BL2–5–BL2–6
  iCloud overview, BL2–2
  movie lengths, BL2–5
  selecting clips, BL2–3
  setting up iMovie Theater, BL2–2–BL2–3
  sharing to iMovie Theater, BL2–3–BL3–6
  trailer lengths, BL2–5
  uploading content
    manually, BL2–5–BL2–6
  Vimeo example, BL2–5
iOS devices, importing from, 14. See also iMovie for iOS
iPads. See also mobile movies
  accessing audio content, 274
  closing Project Settings window, 284
  creating projects on, 261–262
  Fade option, 273
  hiding settings, 272
  making split edits, 293–295
  media library, 264
timeline, 264
trimming with precision, 291–293
Undo button, 269
viewing area, 264
viewing photos, 285
iPhones. See also mobile movies
  accessing audio content, 275
  closing Project Settings window, 284
  creating projects on, 261–262
  Fade option, 273
  Inspector button, 272
  Media Browser button, 267
recording returns to timeline, 271
transition controls, 278
viewing area, 265
viewing clip in browser, 267
viewing photos, 285
iPhoto, accessing, 13, 144–146.
  See also photos
J
jump cuts, covering up, 156–157
K
Ken Burns effect
  behavior of, 169
  controlling frames, 169
  explained, 164, 167
  location in Crop controls, 168
  modifying, 167–172
  modifying in mobile movies, 287–289
  moving crop frames, 171
  removing, 167
  seeing, 165
  Swap button, 171
keyboard shortcuts
  accessing, 45
  backslash (\), 42
  Favorite option, 19–20
  Select All, 32
keyframes, setting for audio, 202–203
keywords
  searching clips for, 152
  using with clips, 147
L
lesson files, installing for iMovie, 5–6
libraries
  copying for backups, 215
  creating on hard drives, 14
Libraries list
  choosing projects from, 184–185
  described, 6
  locating in iMovie window, 41
  showing and hiding, 7
  switching projects in, 80
library
  contents, 4
  events in, 4
  locating, 4
locations, setting with travel maps, 185–187
logos, changing in outline, 64.
  See also studio logos

M
Mac OS bonus lesson
  creating Apple ID, BL1-3
deleting from iCloud,
  BL1-6–BL1-7
deleting from iMovie Theater, BL1-6–BL1-7
entering password, BL1-3
iCloud overview, BL1-2
Play button, BL1-5
selecting clips, BL1-4
setting up iCloud,
  BL1-2–BL1-4
setting up iMovie Theater,
  BL1-2–BL1-4
sharing to iMovie Theater,
  BL1-4–BL1-6
uploading content
  manually, BL1-4
Maps & Backgrounds option
  setting end location, 186
  using, 185–187
marking favorites, 18–22
Match Color Balance button,
  using, 133
media, consolidating for backups, 214
mixing audio. See also audio
equalizing audio,
  199–200
improving quality,
  203–205
keyframing levels within clips, 200–203
setting keyframes,
  202–203
using ducking technique,
  198–199
using Zoom slider, 202
mobile movies. See also iPads; iPhones; movies
adding audio, 270–277
adding cutaways, 295–297
adjusting audio, 270–277
applying titles, 277–283
applying transitions,
  277–283
audio sources, 275
changing speeds, 299
creating projects, 261
deleting clips, 306–308
deleting projects, 306–308
facing in and out, 280–281
fading music up or down,
  273
freeze frames, 299–300
making split edits,
  293–295
modifying Ken Burns effect, 287–289
moving projects, 300–305
rearranging clips, 269–270
replacing background tracks, 276
saving projects, 300–305
sharing to iMovie Theater, 308
slow motion, 299–300
sound effects, 275–276
starting movies, 260–268
switching themes,
  283–284
Theme transition button,
  279
trimming techniques,
  290–293
using photos, 285–289
using playhead, 268–269
zooming in on clips,
  297–299
Movie Properties window,
  accessing, 56
movie trailers. See trailers
moviemaking. See also
filmstrips
choosing projects from library, 184–185
equalizing audio, 199–200
mixing audio, 198–205
recording narration, 193–196
setting locations, 185–187
travel maps for locations, 185–187
trimming with precision editor, 187–193
using audio from precision editor, 190–191
movies. See also editing
  movies; mobile movies;
  one-minute movie; videos
adding photos to, 149–151
adding to iMovie Theater, 36
applying themes to,
  80–81
creating with themes,
  40–41
playing full screen, 57
rearranging clips in, 52
removing clips from, 51
removing themes from,
  96–98
sharing online, 138–140
sharing to Facebook, 58–59
moving
  cutaways, 158–161
events to hard disks, 215–216
projects in mobile movies, 300–305
projects to hard disks, 216–217
music. See also audio; songs
adding, 53–56
auditioning, 53–56
Index

Ducking Volume slider, 180
extending beyond videos, 55
fading out, 115–117
playing with soundtrack, 56
using royalty free, 177–181
music tracks
connecting, 107–108
representing in timeline, 56
musical note, appearance of, 55
muting audio, 112–113

N
narration, recording, 193–196

O
one-minute movie. See also movies; videos
changing clips in trailers, 251–255
changing studio logo, 244
customizing cast members, 243
editing outline, 242–245
filling in storyboard, 245–251
personalizing storyline, 254–256
picking trailer genre, 238–242
using Edit Shot pane, 253–254
outline
changing, 64–65
editing for one-minute movie, 242–245
filling in credit list, 65
pictures. See also iPhoto
adding to movies, 149–151
aspect ratios, 166
cropping in viewing area, 164–167
finding in browser, 147–148
importing, 146–147
inserting into timeline, 150
toggling snapping, 149
using in mobile movies, 285–289
player photos, adding to 
Sports Team editor, 84–86
Player Stats title, entering
information for, 93
players, highlighting in Sports theme, 90–92
Playful theme, considering, 40
playback, pausing, 34
playback speed, changing for clips, 125–126
playing
clips, 15–16, 21
movies full screen, 57
trailers, 66
prayer wheels, 159–160
precision editor
Audio Skimming option, 192
opening, 188
skimming in, 189
trimming audio, 191–193
trimming audio in, 191–193
trimming with, 187–193
using trim pointer, 190
previewing transitions, 123–124

P
pan-and-zoom movement. See Ken Burns effect
pausing playback, 34
Previous button, using, 34
projects. See also backing up
choosing from library, 184–185
deleting in mobile movies, 306–308
moving to hard disks, 216–217
switching in Libraries list, 80

R
ranges. See also selection
ranges
marking as favorites, 21
selecting from clips, 18–22
recording narration, 193–196
rejecting clips, 26–28
removing
clips from events, 29–30
clips from movies, 51
clips in mobile movies, 306–308
Ken Burns effect, 167
portions of timeline, 102–104
projects in mobile movies, 306–308
themes from movies, 96
unselected portions of clips, 104
replacing clips, 98–99
Revert option, using with storylines, 255
royalty-free music, using, 177–181

S
saving projects in mobile movies, 300–305
SD (standard definition) video format
aspect ratio, 209
pixels in, 208
SD and HD handling in same project, 210–212
using Crop button, 211–212
Select All option, using with slips, 32
selecting
Adventure trailer, 63
events, 62
trailer genres, 62–64
selection ranges, refining, 22–24. See also ranges
selections
adding to end, 47–51
dragging to timeline, 41–43
playing from beginning, 42
Share button
using, 35
using with iMovie for iOS, 232
shared movies, removing, 140
sharing
clips in email, 34–36
to iMovie Theater, 306–308
iOS clips to Facebook, 231–234
movies online, 138–140
movies to Facebook, 58–59
Shift key. See keyboard shortcuts
shortcut keys. See keyboard shortcuts
skimmer
appearance of, 15
connecting clips to, 108
enabling to view keywords, 147
skimming clips, 15–16
skin tone balance, adjusting, 131–133
sliders
Clip Size, 18
Ducking Volume, 180
speed, 126
Volume for Voiceover tool, 195
Zoom, 17–18
slow motion, creating in mobile movies, 299–300
snapping, toggling, 149, 160
songs, using parts of, 178. See also music
sorting
filmstrips, 16–18
photos, 149
sound. See audio sound effects. See also video effects
controlling, 113
Traffic, 113
using for audio, 113–114
sound quality, improving, 203–205. See also audio soundtrack, playing music with, 56
speed of playback. See playback speed
speed slider, using, 126
split edits, making in mobile movies, 293–295
splitting clips, 100–102
Sports Team Editor
adding graphics, 84–86
adding player photos, 84–86
adding sports to, 93
adding team logo to, 93
entering information, 82–84
Sports theme. See also themes
adding backgrounds, 86–88
adding titles, 86–88
adding to movie, 81
changing default behaviors, 81
highlighting players, 90–92
instant replay effect, 88–89
Maps & Backgrounds option, 87
Stabilizing feature, using, 135–136. See also clips
storyboard
contents, 65
filling in, 65–71
filling in for one-minute movie, 245–251
placeholders in, 65, 69
playing trailer, 66
storyline text
personalizing, 64–65, 76, 254–256
Revert option, 255
studio logos. See also logos
changing for one-minute movie, 244
changing for trailers, 77
Swap button, using with Ken Burns effect, 171
themes. See also Sports theme
applying to movies, 80–81
changing, 56–57
Playful, 40
removing from movies, 96
switching in mobile movies, 283–284
using with movies, 40–41
Thumbnail Appearance button
making adjustments, 17
toggling waveforms, 202
using with clips, 101
time and date, adjusting for clips, 212–213
timeline
deleting portions of, 102–104
dragging clips into, 46
dragging selections to, 41–43
identifying music tracks in, 56
locating in iMovie window, 41
purple bars in, 42
timeline filmstrips, resizing, 101. See also filmstrips
titles. See also editing titles
applying to mobile movies, 277–283
creating, 136–138
toolbar buttons
described, 6
locating in iMovie window, 41
Traffic sound effect, selecting, 113
trailer genres
picking for one-minute movie, 238–242
selecting, 62–64
trailers
accessing, 77
adding clips to, 67–68
changing clips in, 251–254
changing studio logos, 77
determining clip length, 77
playing, 66
removing clips from, 251
replacing clips in, 72–73
transitions. See also video effects
applying to mobile movies, 277–283
changing default duration, 123
modifying, 123–124
previewing, 123–124
Trash, emptying, 30
travel maps, using to set locations, 185–187
trim pointer, appearance of, 105
trimming
audio in precision editor, 191–193
cutaways, 157
frames, 104–106
mobile movies, 290–291
with precision editor, 187–193
with precision on iPads, 291–293
U
Up Arrow key, using, 34
V
video clips. See also clips
aspect ratios, 166
using audio from, 196–198
video effects. See also sound effects; transitions
best practices, 121
copying and pasting, 121–123
skimming over thumbnails, 121
stopping playback, 121
using, 120–123
video file types, 209
video formats
adjusting clip dates, 212–213
adjusting clip times, 212–213
aspect ratios, 209
consolidating media, 214–217
HD (high definition), 208
iMovie Theater for Mac, 217–218
making backups, 214–217
SD (standard definition), 208
SD and HD in same project, 210–212
videos. See also movies; one-minute movie
downloading for book, 5–6
space requirements, 13
viewer
described, 6
locating in iMovie window, 41
viewing area, cropping photos in, 164–167
Voiceover tool
using to record narration, 194–196
using Volume slider with, 195
volume control
accessing, 115
using with Voiceover tool, 195
W
waveforms, turning off and on, 202
welcome screen, displaying, 4
white balance, adjusting, 128–131
Y
YouTube, sharing movies to, 138–140
Z
Zoom slider
adjusting, 17–18
using with keyframes, 202
zooming clips, 17
The Apple Pro Training Series

Apple offers comprehensive certification programs for creative and IT professionals. The Apple Pro Training Series is both a self-paced learning tool and the official curriculum of the Apple Training and Certification program, used by Apple Authorized Training Centers around the world.

To see a complete range of Apple Pro Training Series books, videos and apps visit: www.peachpit.com/appleprotraining
Differentiate yourself. Get Apple certified.

Stand out from the crowd. Get recognized for your expertise by earning Apple Certified Pro status.

Why become an Apple Certified Pro?

- **Raise your earning potential.** Studies show that certified professionals can earn more than their non-certified peers.
- **Distinguish yourself from others in your industry.** Proven mastery of an application helps you stand out in a crowd.
- **Display your Apple Certification logo.** With each certification you get a logo to display on business cards, resumés, and websites.
- **Publicize your certifications.** Publish your certifications on the Apple Certified Professionals Registry (training.apple.com/certification/records) to connect with clients, schools, and employers.

Learning that matches your style.

- Learn on your own with this Apple Pro Training Series book from Peachpit Press. Advanced titles and video training are also available for select topics.
- Learn in a classroom at an Apple Authorized Training Center (AATC) from Apple Certified Trainers providing guidance.

Visit [training.apple.com](http://training.apple.com) to find Apple training and certifications for:

<table>
<thead>
<tr>
<th>Certifications</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS X</td>
<td>Aperture</td>
</tr>
<tr>
<td>OS X Server</td>
<td>Pages</td>
</tr>
<tr>
<td>Final Cut Pro X</td>
<td>Numbers</td>
</tr>
<tr>
<td>Logic Pro X</td>
<td>Keynote</td>
</tr>
</tbody>
</table>

*Training and Certification*

Copyright © 2014 Apple Inc. All rights reserved.
Lesson Files
None

Time
This lesson takes approximately 25 minutes to complete.

Goals
Sync your media with iCloud
Set up iMovie Theater
Share your movies and trailers with iMovie Theater
Sharing to iMovie Theater

iMovie Theater is a collection of completed movies, trailers, and clips from your library that you can present to whomever you want, whenever you want, and on whatever device you want. It can use iCloud to ensure that your projects and clips automatically appear on all your computers, iOS devices, and Apple TV. Compared to other ways of sharing movies, iMovie Theater gives you a bit more control over who sees your movies and when because you are always in control of the presentation.
**What Is iCloud?**

iCloud is the Apple web service that lets you access your music, photos, documents, and more from all your personal iOS and Mac devices. It’s not just one service, though; it’s more a collection of web applications and functions that work on the different Apple devices.

Like many people, if you own a Mac, an iPhone, and an iPad you commonly come across the problem of downloading a song on one device and wishing you had it on another, or taking a photo with your iPhone and wishing you could see it on your larger iPad or Mac screen. This problem has a few labor-intensive solutions, such as emailing the song or photo to yourself or connecting your phone to your computer and transferring it, but the most effortless way is by setting up iCloud.

With iCloud, your iTunes, iBooks, and App Store purchases are automatically available on all your devices. Contacts, Calendars, notes, reminders, and Safari web browser settings are also updated and kept in sync automatically on every device.

Other applications in iCloud automatically back up your iOS device or locate a missing iOS device or MacBook on a map.

Most importantly, iCloud ensures that your favorite completed movies, trailers, and clips show up in iMovie Theater on all your Macs and iOS devices.

**Setting Up iMovie Theater**

No real setup is required for iMovie Theater if all you want to do is create a central place on your Mac to see all your finished movies, trailers, and clips. But the biggest advantage of iMovie Theater is that it works with iCloud. Share your favorite trailer to iMovie Theater from your iMac and instantly it appears in iMovie Theater on your iPhone, iPad, MacBook, and Apple TV. To get that benefit, you need to set up iCloud.

To set up iCloud, you use the OS X System Preferences.

1. In the OS X Finder, choose System Preferences in the Apple menu, and then click iCloud.

2. In the iCloud window, type your Apple ID and password, and then click Sign In.
NOTE ▶ If you don’t have an Apple ID, click “Create new Apple ID” and follow the onscreen instructions.

3 Select the options for storing mail, contacts, and other content in iCloud as well as the Find My Mac service for locating your misplaced MacBook. Click Next.

NOTE ▶ Selecting these options are not required for iMovie Theater but they are helpful in a general computing sense.

4 Enter your password in the Keychain dialog, and then allow the request for Find My Mac to use your current location information.

iCloud asks you to approve a message that will be sent to your other devices that use the same Apple ID. The message requests approval from those devices since you’ll be sharing content with them. Since it does this through your Apple ID, it’s fairly safe to assume you control those other devices.

5 On the message request, click Allow.

6 In the iCloud window, click the Options button next to Documents & Data.
Make sure the iMovie checkbox is selected, and then close the iCloud window. iCloud setup is complete. Now you need to connect your iMovie Theater to iCloud.

In iMovie, choose iMovie > Preferences.

Select the “Automatically upload content to iCloud” checkbox.

You can leave “Automatically upload content to iCloud” deselected and upload content manually. Each poster in the Theater will have an “Upload to iCloud” icon in the upper-right corner. Clicking the icon will send the movie to iCloud.

Now, anytime you share to iMovie Theater, the movies you share are uploaded automatically. It’s all done in the background so you can continue to play in iMovie as it happens. The activity indicator in the upper-right corner of the iMovie window will appear while the upload is happening and disappear when it is complete.

If you sign out of your iCloud account on your Mac, all the iMovie Theater movies will disappear from the Theater. They are not deleted but, since they are stored in your iCloud storage, when you sign out they can’t be accessed. They’ll reappear when you sign back in.

**Sharing to iMovie Theater**

Using iMovie Theater is as easy as using any other share option in iMovie.

1. In the browser, select a movie, trailer, or clip.

   You can select an entire clip or just a range within a clip to send to iMovie Theater.

2. In the toolbar, click Share, and then click Theater from the pop-up menu.
The iMovie window switches to show the Theater. A poster with a representative frame from your movie indicates the sharing progress. During this process, iMovie creates multiple copies of your movie tailored for playback on different devices. You’ll see only one poster in the theater for the movie, but iMovie Theater intelligently switches to the correctly formatted copy of your movie based on the device you are viewing it from.

Below the selected poster is the title, duration, and the time the item was created in the Theater.

3 Click the Play button on the poster to play the item full screen.
NOTE ► Movies, trailers, and clips uploaded to iCloud cannot be longer than 15 minutes.

iMovie Theater is not meant as a replacement for posting your movies to Facebook, YouTube, Vimeo, or any other sharing site. It is meant as an up-to-date personal repository of all your finished movies, trailers, and clips. When you share to popular video sharing sites, you have the option to have the movie go to iMovie Theater as well.

4 Select another movie from your library.

5 In the toolbar, click Share, and then click Vimeo from the pop-up menu.

In the Share dialog, selecting the “Add to Theater” checkbox automatically adds the movie to iMovie Theater when it posts it to Vimeo.

Deleting from iMovie Theater and iCloud

You can remove shared projects and clips from both iCloud and the Theater. If you delete a project or clip from the Theater, it automatically gets deleted from iCloud (and therefore every device that had access to it). If you remove it from iCloud, you have the option to leave it in the Theater of the device you are on.

1 In the iMovie Theater on your Mac, select a poster.
2 Press Delete.

NOTE Deleting items from iMovie Theater does not delete them from your event in the iMovie library. If you delete an item from iMovie Theater and/or iCloud, you can always select the item in the library and share it to the Theater again.

In the dialog that appears, you have three choices:

- Delete Everywhere: Removes it from iCloud and the Theater you are currently viewing; no copies of the movies will be left on any device.
- Delete from iCloud: Leaves a copy on the Mac you are currently on but removes any copies on any other devices that use this iCloud account.
- Cancel the operation altogether.
Lesson Review

1. Where do you sign up for iCloud?
2. True or false? The only way to upload movies to iCloud is to tell iMovie to upload them automatically.
3. How do you delete a movie from iMovie Theater on every device?

Answers

1. Enter your Apple ID in the iCloud window in the System Preferences.
2. False. You can manually upload movies to iCloud by clicking the “Upload to iCloud” icon in the upper-right corner of a poster.
3. Select a poster in iMovie Theater and press Delete. In the dialog that appears, click Delete Everywhere.
Lesson Files

None

Time

This lesson takes approximately 25 minutes to complete.

Goals

Sync your media with iCloud
Set up iMovie Theater
Share to your movies and trailers with iMovie Theater
Sharing to iMovie Theater

iMovie Theater is a collection of completed movies, trailers, and clips from your library that you can share to all your devices. Compared to other ways of sharing movies, iMovie Theater gives you a bit more control over who sees your movies and when, because you’re always in control of the presentation.

Although this lesson is dedicated to iMovie Theater for iOS devices, it covers many of the same setup requirements and technology descriptions found in Bonus Lesson 1.
What Is iCloud?

iCloud is the Apple web service that lets you access your music, photos, documents, and more from all your personal iOS and Mac devices.

Like many people, if you own a Mac, an iPhone, and an iPad, you commonly come across the problem of making a movie in iMovie for Mac and wishing you could see it on your iPhone or Apple TV. There are a few solutions, such as sharing it with the world on social networks, but the most effortless way is by setting up iCloud and iMovie Theater.

With iCloud, your iTunes, iBooks, and App Store purchases, as well as documents like the projects you create in iMovie, are automatically available on all your devices.

Setting Up iMovie Theater

To begin sharing trailers and movies to all your personal devices via iMovie Theater, first you need to set up iCloud on your iOS devices.

1. On your personal iOS device, go to Settings, and then tap iCloud.

2. If you didn't set up your Apple ID and iCloud the first time you started your iOS device, enter it here.

3. After you enter your Apple ID and password, tap Sign In.
   A popover appears, asking to use your current location for the Find My iPad feature.

4. Tap Don't Allow or OK based on your preference.

5. Tap Documents & Data, and make sure iMovie is enabled.

Now anytime you share to iMovie Theater, the movies are uploaded automatically.
If you sign out of your iCloud account on your iOS device, all the movies will disappear from iMovie Theater. They’re not deleted, but you need to be signed in to iCloud to access them, as with any files stored in iCloud. They’ll reappear when you sign back in.

**Sharing to iMovie Theater**
Using iMovie Theater is as easy as using any other Share option in iMovie.

1. **Select a movie, trailer, or clip you want to share.**

   **Tip** You can select an entire clip or just a range within a clip to send to iMovie Theater.

2. **Tap Share, and then tap iMovie Theater.**

   ![iMovie Theater screenshot]

   iMovie exports the movie. When the export is complete, the screen switches to show the Theater with posters from all your complete projects.
3 Tap a movie to see the details screen, and then click the Play button to play the item full screen.
Beside the poster is the title, duration, and time the item was created in the Theater.

**NOTE** ▶ Movies, trailers, and clips uploaded to iCloud cannot be longer than 15 minutes.

iMovie Theater is not meant as a replacement for posting your movies to Facebook, YouTube, Vimeo, or any other sharing site. It’s meant as your personal up-to-date repository of all your finished movies, trailers, and clips. So when you share to popular video sharing sites, you have the option to send the movie to iMovie Theater as well.

4. Select another movie from your library.

5. Tap Share, and then tap Vimeo.

![Share Project on Vimeo](image)

Enabling the Add to Theater option will automatically add the movie to iMovie Theater when it posts it to Vimeo.

**Deleting from iMovie Theater and iCloud**

You can remove shared projects and clips from both iCloud and iMovie Theater. If you delete a project or clip from the iMovie Theater, it automatically gets deleted from iCloud (and therefore every device that had access to it), but if you remove it from iCloud, you have the option to leave it in the Theater of the device you’re on.

1. In iMovie Theater view, tap a poster.

2. In the details screen, tap the Trash button.
NOTE ▶ Deleting items from iMovie Theater does not delete them from your event in the iMovie library. If you delete an item from iMovie Theater and/or iCloud, you can always select the item in the library and share it to iMovie Theater again.

You have three delete options:

▶ Delete Everywhere: Removes it from iCloud and the Theater you are currently looking at. No copies of the movies will be left on any device.
▶ Remove from iCloud: Leaves a copy on the iOS device you're currently on but removes any copies on any other devices that use this iCloud account.
▶ Remove from device: Leaves a copy on iCloud for your other devices but removes it from the current device.

This guide covered a lot of ground. I hope the moments you record are that much more enjoyable after you’ve learned a few things about iMovie and moviemaking. A lot of fun is to be had just sitting back and viewing your video clips in the browser, without ever having to make a movie. Turning those moments into short movies or trailers just adds to the fun you can have, while you're on the go on your mobile device. But nothing will bring you more joy than sharing those moments with the important people in your life.
Lesson Review

1. Where do you sign up for iCloud?

2. How do you share a project to iMovie Theater?

3. How do you delete a movie from iMovie Theater on every device?

Answers

1. Enter your Apple ID in the iCloud window in the System Preferences.

2. Tap a project, tap Share, and then tap iMovie Theater.

3. Tap a poster in iMovie Theater, and then from the details screen tap the Trash button. In the popover, tap Delete Everywhere.